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Using the USB interface for Windows and 
Macintosh users

To connect the printer to a USB port, you need a standard, 
shielded USB cable. Follow the steps below.

1. Make sure that both the printer and the computer are turned 
off.

2. Plug the appropriate 
end of the cable into the 
USB port at the back of 
the printer. (The shape 
of the end that fits the 
printer differs from that 
of the end that fits the 
computer.)

3. Connect the other end of 
the cable to the 
computer’s USB port.
�������



Installing the Printer Software

After connecting the printer to your computer, you must install 
the software that is included on the “Printer Software for EPSON 
Stylus COLOR 880” CD-ROM shipped with your printer. 

Your printer software CD-ROM includes the following:

❏ Printer driver and utilities
The printer driver runs, or “drives,” your printer; use it to 
make settings such as print quality, speed, media type, and 
paper size. The Nozzle Check, Head Cleaning, and Print Head 
Alignment utilities help you to keep your printer in top 
operating condition. EPSON Status Monitor 3 (for 
Windows 98, 95, 2000, and NT 4.0) or EPSON StatusMonitor 
(for Macintosh) notifies you of printer errors and displays 
printer status information, such as the amount of ink 
remaining. The Status Monitor also guides you through the 
ink replacement process.

❏ Online guides
The online Reference Guide and the Color Guide help you to 
learn more about your printer and color printing.

If you are using the floppy disk version of the software, make a 
backup copy of the EPSON printer software disk before you begin 
installation. If you wish to make a floppy disk version of the 
printer software, you can use the driver disk creation utility that 
is included on the CD-ROM.

Follow the instructions in the appropriate section below to install 
the printer software. If you are DOS user, see “Printing with DOS” 
in the Daily Use guide.
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For Windows 98, 95, 2000, and NT 4.0 users

Windows 98, 95, 2000, and NT 4.0 users must first install the 
printer software, and then, if you are connecting via the USB port, 
check to ensure that the USB cable is correctly installed. If you are 
connecting via the parallel port, proceed to “Installing the Ink 
Cartridges” on page 17 after installing the software.

Installing the software
Follow the steps below to install the printer software.

1. Make sure that your printer is off.

2. Turn on your computer and start Windows. If the New 
Hardware Found screen or any other Wizard appears, click 
Cancel.

3. Insert the printer software CD that is shipped with your 
printer in the CD-ROM drive. The Installer dialog box opens. 
(For floppy disk users, insert the disk in the disk drive and 
double-click the My Computer icon, the floppy disk drive 
icon, and then Setup.exe.) 

4. Select Install Printer 
Driver/Utility and click . 
Then, click OK in the dialog 
box that appears to start the 
printer software 
installation.
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Note:
It is possible to install the Reference Guide on your hard drive from 
the Installer dialog box, as shown at the right. To install the guide, 
select Online Guide and then click . Then, click Install 
Reference Guide and follow the on-screen instructions. When 
the installation is complete, an ESC880 Guide icon appears in the 
EPSON folder. Double-click the icon to open the guide.

5. Follow the on-screen instructions to turn on your printer. 

For Windows 98 users, the printer port configuration starts 
automatically.
For printers connected via USB cable, the USB device driver 
installation starts automatically at this point. A message will 
appear asking you to restart your computer. Follow this 
instruction.

6. After turning on the printer, 
the Setup utility opens 
automatically. 
Follow the on-screen 
instructions to install the ink 
cartridges, check the print 
head nozzles, and clean the 
print head. When a message 
appears informing you that 
the setup is complete, click OK.

Note:
If the Setup utility does not start, proceed to“Installing the Ink 
Cartridges” on page 17 to install the ink cartridge using the 
printer’s control panel.

7. When a message appears informing you that the installation 
is complete, click OK.
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Note:
If an error message appears, either the printer driver or the EPSON 
USB printer device driver is not installed correctly. See 
"Troubleshooting" in the Daily Use guide for details.

After the setup is complete, proceed to “Printing Your First Page” 
on page 24 to print your first page.

Ensuring that the USB driver is installed correctly
After installing the software, USB users should follow the 
directions below to confirm that the USB driver is installed 
correctly.

Note:
The illustrations used in this section show the procedure for 
Windows 98.

1. Click the Start button, point to Settings, and then click 
Printers. Make sure that the icon for your printer is displayed 
in the Printers window.

2. Select the icon for your 
printer, then click Properties 
on the File menu.
      13



3. For Windows 98 uses, click 
the Details tab and make sure 
that EPUSBx: (EPSON Stylus 
COLOR 880) is displayed in 
the Print to the following port 
list box. For Windows 2000 
user’s click the Ports tab and 
make sure that USBxxx, 
EPSON Stylus COLOR 880 is 
displayed in the Print to the 
following port(s) list box.

Note:
If the correct port is not 
displayed, refer to the 
"Troubleshooting" section of the 
Daily Use guide or the Online Guide.

For Windows 3.1 users

Follow the steps below to install the software in Windows 3.1.

1. Make sure that Windows 3.1 is running and the Program 
Manager window is open.

2. Insert the printer software CD that is shipped with your 
printer in the CD-ROM drive. (If you use the floppy disk 
version, insert the disk in the disk drive.)

3. Click Run on the File menu. The Run dialog box appears. In 
the Command Line text box, type D:SETUP and click OK. The 
installation program copies the printer software files.
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Note:
If the CD-ROM drive is 
assigned a drive letter 
other than “D” or if you 
are using the floppy disk 
version of the software, 
substitute the appropriate letter.

4. When the installation is complete, click OK to exit the 
installation program. 

The installation program automatically selects this printer as the 
default printer for Windows applications.

For information on accessing and using the software, see “Using 
the Printer Software for Windows” in the Daily Use guide.

For Macintosh users

Macintosh users must first install the printer software, and then 
select the printer in the Chooser.

c
Caution:
Turn off all virus protection programs before installing the 
printer software.

Installing the software
Follow the steps below to install the printer software.

1. Turn on your Macintosh and insert the software CD in the 
CD-ROM drive. The contents of the EPSON printer software 
CD are displayed.
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2. If a single Installer icon is displayed, double-click the icon. If 
separate folders containing installer icons for several 
languages are displayed, double-click the folder for your 
preferred language, then double-click the Installer icon inside 
it.

Note:
It is possible to install the Reference Guide on your hard drive from 
the printer software CD-ROM. To install the guide, click Install 
Reference Guide and follow the on-screen instructions. When 
the installation is complete, a View Reference Guide icon 
appears in the EPSON folder. Double-click the icon to open the 
guide.

3. In the initial dialog box, 
click Continue. The 
Installer dialog box opens.

4. Make sure that the Install 
Location box displays the 
correct drive to install to, 
then click Install.

5. When a message appears informing you that the installation 
is complete, click Restart to restart your computer.

Selecting your printer in the Chooser
After you have installed the printer software on your Macintosh, 
you must open the Chooser and select your printer. You need to 
select a printer the first time you use it or whenever you want to 
switch to another printer. Your Macintosh will always print using 
the last printer selected.
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1. Choose Chooser from the 
Apple menu. Then click 
your printer's icon and the 
port that your printer is 
connected to.

2. Select the appropriate 
Background Printing 
radio button to turn 
background printing on or off.

When background printing is on, you can use your Macintosh 
while it is preparing a document for printing. In order to use 
the EPSON Monitor3 utility to manage print jobs, background 
printing must be turned on.

3. Close the Chooser.

Installing the Ink Cartridges

Windows 98, 95, 2000, and NT 4.0 users can use the Setup utility 
to install ink cartridges. Windows 3.1 and Macintosh users must 
use the printer’s control panel. Refer to the appropriate section 
below.

Using the Setup utility

If you have Windows 95, 98, 2000, or NT 4.0 installed on your 
computer, the Setup utility will open automatically when the 
printer software installation is complete. Follow the on-screen 
instructions.
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Using the printer's control panel

If you can not access the Setup utility, use the printer’s control 
panel to install the ink cartridges.

w
Warning: 
The ink cartridges are self-contained units. Under ordinary use, 
ink will not leak from a cartridge. If ink does get on your hands, 
wash them thoroughly with soap and water. If ink gets into your 
eyes, flush them immediately with water.

Note:
Do not open the ink cartridge packages until just before you install them; 
otherwise, the ink may dry up.

Install the ink cartridges as described below.

1. Lower the output tray 
and then open the 
printer cover.

2. Press the P 
power button 
to turn on the 
printer.
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The print head moves left to the ink cartridge installation 
position. The P power light flashes and the B and A ink out 
lights come on.

c
Caution:
Do not move the print head by hand; doing so may damage 
the printer.

3. Lift up the ink cartridge 
clamps.

Note:
Do not remove the small 
sponges that are attached 
to the ink cartridge 
clamps.

4. Open the ink cartridge packages and remove only the yellow 
tape seals from each cartridge.
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c
Caution: 
❏ You must remove the yellow tape seals from the 

cartridges before installing them; otherwise, a fatal error 
will occur and the cartridges will become unusable.

❏ Do not remove the blue portion of the tape seals from the 
cartridges; otherwise, the cartridges may become clogged 
and unable to print.

❏ Do not remove the tape seals from the bottom of the 
cartridges; otherwise, ink will leak.

5. Place the cartridges 
gently in their holders 
with the labels facing 
up. The color ink 
cartridge, which is 
larger, goes on the right 
and the black ink 
cartridge goes on the 
left. Do not press down 
on the cartridges.

Note:
Install both ink cartridges. If either of the cartridges is not installed, 
the printer will not work.

6. Lower the ink cartridge clamps until they lock in place.

c
Caution:
Once you install the ink cartridges, do not open their clamps 
again until you replace the ink cartridges; otherwise, the 
cartridges may become unusable.
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7. Press the B A cleaning 
button. The printer 
moves the print head 
and begins charging the 
ink delivery system. 
This process takes about 
one and a half minutes.

While the ink is 
charging, the P power light flashes and the printer produces 
a variety of mechanical sounds. These sounds are normal. 
When the ink delivery system has been charged, the print 
head returns to its home (far right) position and the P power 
light comes on.

c
Caution: 
Never turn off the printer while the P power light is flashing.

8. Close the printer cover.

Checking the Printer

Before printing your first page, load plain paper in the printer and 
print a nozzle check page to make sure that the printer is working 
correctly. If the nozzle check is unsatisfactory, you may need to 
clean the print head.

Loading paper

Follow the steps below to load plain paper in the printer.
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1. Lower the output tray and slide out the extension, then slide 
the left edge guide so that the distance between the edge 
guides is slightly wider than the width of your paper.

2. Fan a stack of paper, then tap it on a flat surface to even the 
edges.

3. Load the stack of paper in the sheet feeder with the printable 
side up and the right edge of the paper resting against the 
right edge guide. Then slide the left edge guide against the 
left edge of the paper.

Note:
❏ Always load paper into the sheet feeder short edge first.

❏ Make sure that the paper stack fits under the arrow mark on the 
inside of the edge guide.

edge guide

output tray

printable 
side up
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Checking the print head nozzles

Make sure that 
the printer is 
turned off. Hold 
down 
the S load/eject 
button (➀  in the 
illustration) and 
press 
the P power 
button (➁  in the illustration) to turn on the printer. Then release 
both buttons.

Here are sample printouts.

If the nozzle check page does not print satisfactorily (for example, 
if any segment of the printed lines is missing), then you should 
clean the print head as described below. If the printout is 
satisfactory, you are ready to print your first page. See “Printing 
Your First Page” for instructions. 

Cleaning the print head

Follow the steps below to clean the print head.

1. Make sure that the P power light is on and that both the 
B black and A color ink out lights are off.

Segments are missing

Good sample Print head needs to be cleane
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2. Hold down 
the B A 
cleaning 
button for 
three 
seconds.

The printer 
starts 
cleaning the 
print head and the P power light begins flashing. Print head 
cleaning takes about thirty seconds to complete.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

3. When the P power light stops flashing, print a nozzle check 
pattern to confirm that the head is clean and to reset the 
cleaning cycle.

If print quality hasn’t improved after repeating the nozzle 
checking and cleaning procedures four or five times, contact your 
dealer.

Printing Your First Page

After making sure that your printer is operating correctly, you are 
ready to print your first page. To familiarize yourself with the 
printer software, we recommend that you print one of the sample 
files provided with your printer software. To print a sample file, 
follow the instructions for Windows or Macintosh in this section.

If you choose to print your own document instead, load the 
appropriate paper in the printer, open the document in your 
application, then proceed to step 4 in the relevant section below, 
making changes where appropriate.
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Note:
❏ See your software manual for details on how to use an application.

❏ Depending on the type of document that you are printing and the 
type of paper that you are using, you may have to make settings that 
differ from those described in this section.

For Windows users

Follow the steps below to print the sample file.

1. Make sure that A4 or Letter size EPSON Photo Quality Ink Jet 
Paper is loaded in the printer.

2. Insert the printer software CD in the CD-ROM drive. If the 
Installer dialog box appears, click  Quit.

3. Double-click the My Computer icon. Right-click the CD-
ROM icon and click Open. Then double-click the 
sample.bmp file to open it.

4. To change the printer driver 
settings, click Print on the 
File menu. A Print dialog 
box similar to the one on the 
right opens. (This example 
is from Paint).

5. Select your printer in the 
Name list box, then click 
Properties. The printer 
driver opens
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6. Click the Main tab, then select 
Photo Quality Ink Jet Paper 
in the Media Type list box.

7. Select Color as the Ink setting.

8. Select Automatic as the Mode 
setting. When Automatic is 
selected, the printer software 
optimizes other settings 
according to the Media Type 
and Ink settings that you 
make.

9. Click the Paper tab, then click anywhere in the Paper Size list 
box and select the paper size that is loaded in the printer.

10. Click OK at the bottom of the printer driver window. You 
return to the Print dialog box (or a similar dialog box).

11. Click Close, Print, or OK to print. You may need to click a 
combination of these buttons.

While printing is in progress, the EPSON Progress Meter (for 
Windows 98, 95, 2000, and NT 4.0) or the EPSON Despooler 
dialog box (for Windows 3.1) is displayed, showing the printing 
progress and the status of your printer.

For Macintosh users

Follow the steps below to print the sample file.

1. Make sure that A4 or Letter size paper is loaded in the printer.

2. Insert the printer software CD in the CD-ROM drive.

3. Open the EPSON folder and double-click the README file.
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4. Click Page Setup on the File menu. The following dialog box 
appears.

5. Select the paper size that is loaded in the printer from the 
Paper Size list box. 

6. Select Portrait as the Orientation setting.

7. After making your settings, click OK to close the Page Setup 
dialog box.

Note:
You cannot print from the Page Setup dialog box. You can only print 
from the Print dialog box.

8. Click Print on the File menu. The Print dialog box opens.

9. Select Plain Paper from the Media Type list.

10. Select Color as the Ink option.
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11. Select Automatic as the Mode setting. When Automatic is 
selected, the printer software optimizes other settings 
according to the Media Type and Ink settings that you make.

12. Click Print to start printing.
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Printer Parts and Functions

Printer Parts and Control Panel Functions

sheet feeder

edge guides

output tray extension

output tray

printer cover

paper support

ink cartridge clamps

control panel
adjust lever

print head
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Buttons

Lights

Button Function

P
Power

Turns the printer on and off. 

Clears the printer's memory if pressed twice while the 
power is on.

S
Load/eject

Loads or ejects paper if pressed and released within 
2 seconds. 

Resumes printing if pressed and released after a paper 
out error.

B

A
Cleaning

Moves the print head to the ink cartridge replacement 
position if pressed for 3 seconds while the B black or 
A color ink out light is flashing or on.

Returns the print head to its home position after ink 
cartridge replacement.

Performs print head cleaning if pressed for 3 seconds 
while the B black or A color ink out light is off.

Light Printer Status

P
Power

On when the printer is on.

Flashing when the printer is receiving data, printing, 
replacing an ink cartridge, charging ink, or cleaning 
the print head.

S
Paper out

On when the printer is out of paper. Load paper in the 
sheet feeder, then press the S load/eject button to 
resume printing.

Flashing when the paper is jammed. Take all of the 
paper out of the feeder, then reload the paper. If the 
light continues to flash, turn off the printer and gently 
pull all the paper out of the printer.

B
Black ink 
out

On when the black ink cartridge is empty. Replace the 
black ink cartridge (T019).

Flashing when the black ink cartridge is nearly empty.

A
Color ink 
out

On when the color ink cartridge is empty. Replace the 
color ink cartridge (T020).

Flashing when the color ink cartridge is nearly empty.
30      



      31



Loading Special Paper, Envelopes, and 
Other Media

Loading Special Paper and Other Media

You can print on a wide variety of special media, including ink 
jet paper, photo quality glossy film, photo paper, transparencies, 
index cards, and adhesive sheets.

When loading special media that is distributed by EPSON, read 
the instruction sheets packed with the media first and keep the 
points listed below in mind. For more details on using special 
media, see “Paper Handling” in the online Reference Guide.

❏ Make sure that the printable side of the paper is facing up 
when loading media into the sheet feeder. See the instruction 
sheets packed with the media to determine which side is the 
printable surface. Some types of media have cut corners to 
help identify the correct loading direction, as shown in the 
illustration.

cut corner

printable
side up
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❏ Make sure that the paper stack fits under the arrow mark that 
is located on the inside surface of the left edge guide.
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Loading capacities for EPSON special media

See below to find the loading capacities for EPSON special media.

* Do not print on support sheets that are loaded under special media.

Media Type Loading Capacity

360 dpi Ink Jet Paper 
and Photo Quality Ink 
Jet Paper

Up to the arrow mark on the left edge 
guide.

Photo Quality Ink Jet 
Cards, Ink Jet Note 
Cards, and Ink Jet 
Greeting Cards

Up to 30 cards.
Always place the included support 
sheet* under the cards.

Photo Quality Glossy 
Film

One sheet at a time or a maximum of 20 
sheets. When loading multiple sheets, set 
the minimum top margin of the page to 
30 mm.
Always put a support sheet* or a sheet of 
plain paper under the glossy film.

Ink Jet Transparencies Up to 30 transparencies.
Always put a sheet of plain paper under 
the stack of transparencies.

Photo Quality Self 
Adhesive Sheets

One sheet at a time.

Photo Paper Up to 20 sheets.
For 200 × 300 mm Photo Paper, you can 
only load one sheet at a time. Always put 
a support sheet* under the stack of 
Photo Paper.

Premium Glossy Photo 
Paper

One sheet at a time.

Photo Stickers 16 and 
Photo Stickers 4

One sheet at a time.

Panoramic Photo Paper 
and Iron-On Cool Peel 
Transfer Paper

One sheet at a time.

Matte Paper-
Heavyweight

Up to 20 sheets.
Always put a support sheet* under the 
stack of Matte Paper-Heavyweight.
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About special media cleaning sheets

Cleaning sheets that are packaged with EPSON special media 
should not be used with this printer. The cleaning function 
performed by these sheets is not necessary with this type of 
printer and the sheets may jam in the printer.

Loading Envelopes

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes in the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the 
total thickness of the stack of envelopes exceeds 10 mm, press each 
envelope in the stack flat before loading.

❏ Set the adjust lever to the “+” position. To do this, open the 
printer cover and reposition the lever.

Note:
❏ Return the adjust lever to the “0” position, which is the normal 

position, after you finish printing on envelopes. Leaving the 
lever in the “+” position may cause gaps to appear in images 
that are printed on other media.

❏ When the adjust lever is in the “+” position, make sure that the 
High Speed check box in the printer driver’s Advanced dialog 
box is cleared. To clear this check box, you may also need to 
change the Print Quality setting.
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❏ Load envelopes flap edge first with the flap side down, as 
shown in the illustration.

❏ Do not use envelopes that are curled or folded. Flatten the 
envelope flaps before loading. Avoid using envelopes that are 
too thin as they may curl during printing.

❏ Select Plain Paper as the Media Type setting in the printer 
driver.

Acceptable envelopes sizes are:
No.10, DL, C6, 132 mm × 220 mm
36      



Printing with Windows

Printer Software Introduction

The printer software CD-ROM which comes with your printer 
includes a printer driver and printer utilities. The printer driver 
lets you choose from a wide variety of settings to achieve the best 
results with your printer. The printer utilities help you to check 
the printer and keep it in top condition.

Getting more information

For information on using the printer driver, see “Making Changes 
to Printer Settings” on page 39.

For information on using the printer utilities, see “Using the 
Printer Utilities” in the online Reference Guide.

Note:
The specific features available in the printer software vary, depending 
on the version of Windows that you are using.

Online help provides more information about the printer 
software. See “Getting Information Through Online Help” on 
page 45 for instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows 
applications, from the Windows Start menu (Windows 98, 95, 
2000, and NT 4.0), or from the Control Panel (Windows 3.1).
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When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application that you are using.

When you access the printer software from the Start menu, the 
settings that you make apply to all of your Windows applications.

Refer to the appropriate section below.

From Windows applications
Follow the steps below to access the printer software from 
Windows applications.

1. From the File menu, click Print or Print Setup.

2. In the dialog box that appears, click Printer, Setup, Options, 
or Properties. (Depending on your application, you may need 
to click a combination of these buttons.) The printer driver 
opens.

From the Windows Start menu (Windows 98, 95, 2000, and 
NT 4.0)

Follow the steps below to access the printer software from the 
Start menu.

1. Click Start, point to Settings, then click Printers.

2. For Windows 98 and 95, select your printer, then click 
Properties on the File menu. For Windows 2000, select your 
printer, then click Printing Preferences on the File menu. For 
Windows NT 4.0, select your printer, then click Document 
Defaults on the File menu. The printer driver opens.

From the Control Panel (Windows 3.1)
Follow the steps below to access the printer software from the 
Control Panel in Windows 3.1.
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1. Double-click the Control Panel icon in the Main program 
group.

2. Double-click the Printers icon.

3. Select your printer in the Installed Printers list.

4. Click Setup. The printer driver opens.

Making Changes to Printer Settings

The printer driver features the following menus and settings.

Note:
The Layout menu is available only for Windows 98, 95, 2000, and 
NT 4.0 users.

Main: Media Type, Ink, Mode, Print Preview

Paper: Paper Size, Copies, Orientation, Printable Area

Layout: Reduce/Enlarge, Double-Sided Printing, Multi-Page, 
Watermark
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The Mode settings on the Main menu are arranged to give you 
three levels of control over the printer driver, as explained below.

Automatic  When this mode is selected, the printer 
driver takes care of all detailed settings 
based on the current Media Type and Ink 
settings. To make the Ink setting, click 
Color to print in color, or Black to print in 
black-and-white or grayscale. 
Depending on the media selected in the 
Media Type list (while Automatic is 
selected), a slider appears under the 
Custom radio button that lets you choose 
either Quality or Speed. Select Quality 
when print quality is more important than 
speed.

PhotoEnhance This mode provides a variety of image-
correction settings that you can apply to 
your photos before printing. 
PhotoEnhance does not affect your 
original data. This mode is only available 
when printing 16-, 24-, or 32-bit color data.
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In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the Paper and Layout menus. For more 
information about the Paper and Layout menus, see your online 
Reference Guide.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches 
the media that is loaded in the printer. To determine what Media 
Type you are using, locate your media in the list found under 
“Media types” on page 83, and refer to the corresponding Media 
Type under which it is grouped (shown in larger type). For some 
types of media, there are several Media Type settings to choose 
from.

Note:
For Windows 3.1 users, if the Media Type that you wish to select does 
not appear in the list, make the Print Quality setting in the More 
Settings dialog box first. To access this dialog box, click the Advanced 
button on the Main menu, then click More Settings.

Custom  This mode offers ready-made settings 
designed for printing text and graphs and 
for applying a color-matching method. 
You can also create and save your own 
custom settings using the settings in the 
Advanced dialog box.
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Previewing your printout

Select the Print Preview check box on the Main menu to see a 
preview of your document before printing.

Note:
This feature is not available for Windows 3.1.
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When you send a print job to the printer, the Print Preview 
window opens, allowing you to make changes before printing.

The Preview dialog box contains several icon buttons that allow 
you to perform various functions. See online help for each 
function.

You can also manipulate the previewed document in the 
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview.

❏ Select and print any or all pages. 

❏ Magnify the previewed document. To do this, click View and 
then Magnify to open the Magnify window, which magnifies 
the area of the previewed document which is outlined by a 
red box. By dragging the red box, you can change which part 
of the document is magnified.
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❏ View the individual pages that comprise a poster. The Poster 
window opens automatically when you send a print job while 
Poster is selected as the Multi-Page option on the Layout 
menu. From this window, you can view the individual pages 
which make up a poster. You can also open this dialog box by 
clicking View and then Poster.

❏ Apply watermarks. The watermark that you select will 
appear in the previewed image. For detailed information on 
customizing watermarks, see “Printing a watermark on your 
document” in the online Reference Guide. 

❏ Specify which pages in the document you would like printed 
using the Add and Remove features. To add or remove a page, 
you must first click the page icon in the list appearing at the 
left side of the preview window. Then add or remove it using 
the commands on the Print Options menu.

Note:
❏ When using the double-sided printing feature, the Preview window 

allows you to toggle between pages in the print job by clicking the 
appropriate page in the list at the left side of the screen. The pages 
are listed in two columns, Front and Back. The pages in the Front 
column will print first. The page numbers listed refer to pages of the 
print job, and may contain more than one document page.

❏ If it is necessary to reprint part of a double-sided print job, select 
each page of the print job that does not need to be reprinted in the 
list at the left side of the screen, then click Remove Page on the 
Print Options menu. Make sure that the paper is loaded properly so 
that the print job will start on the correct side of the correct page.

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.
44      



Getting Information Through Online Help

Your printer software has an extensive online help feature, which 
provides you with instructions on printing, making printer driver 
settings, and using the printer utilities. In Windows 98, 95, 2000, 
and NT 4.0, you can access online help from an application or 
from the Windows Start menu. In Windows 3.1, you can access 
online help through the EPSON program group. Refer to the 
appropriate section below.

Accessing help from an application

To access help from an application, open the application’s File 
menu and choose Print or Print Setup. Then click Printer, Setup, 
Options, or Properties. (Depending on the application, you may 
need to click a combination of these buttons.) Click Help at the 
bottom of the Main, Paper, Layout, and Utility menu for help 
related to that menu.

For Windows 98, 95, 2000, and NT 4.0, you can get specific help 
related to any item on a menu by right-clicking the item, then 
clicking the What's This? command in the shortcut menu that 
appears. The help contents window opens.

Accessing help from the Windows Start menu

To access help from the Start menu, click the Start button, point 
to Programs and then to Epson (for Windows 98 and 95) or 
EPSON Printers (for Windows 2000 and NT 4.0), then click 
EPSON Stylus COLOR 880 Help. The help contents window 
opens.
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Accessing help from Windows 3.1

To access help in Windows 3.1, open the EPSON program group 
and click the EPSON Stylus COLOR 880 Help icon. The help 
contents window opens.
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Printing with Macintosh

Printer Software Introduction

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

For information on using the printer driver, see “Making Changes 
to Printer Settings” on page 47.

For information on using the printer utilities, see “Using the 
Printer Utilities” in the online Reference Guide.

You can also get more information about the printer software by 
clicking the help icon in any of the dialog boxes in the printer 
driver.

Making Changes to Printer Settings

You will find the printer driver settings in the following dialog 
boxes.

❏ Print dialog box (click Print on the File menu of your 
application or click Options in the Page Setup dialog box)

❏ Background Printing dialog box (click the  Background 
Printing icon button located in the Print dialog box)

❏ Page Setup dialog box (click Page Setup on the File menu of 
your application)
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❏ Layout dialog box (click the  Layout icon button in the Print 
dialog box)

❏ Preview dialog box (click the  Preview icon button in the 
Print dialog box and then click Preview)

The Mode settings in the Print dialog box are arranged to give you 
three levels of control over the printer driver.

The Mode settings are explained below.

Automatic When this mode is selected as the Mode 
setting in the Print dialog box, the printer 
driver takes care of all detailed settings 
based on the current Media Type and Ink 
settings. To make the Ink setting, click 
Color to print in color, or Black to print in 
black-and-white or grayscale. 
Depending on the media that you 
choose in the Media Type list (while 
Automatic is selected), a slider appears 
to the right of the Mode options that lets 
you choose Quality or Speed. Select 
Quality when print quality is more 
important than speed.
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